Engineering and
Computer Science

User Guide document for FRDM-KL25Z Evaluation
board, Keil-MDKS software development environment
and mbed development platform

Course Instructor:
Dr.Otmane Ait Mohamed
Prepared by:
MohammedHossein Askari Hemmat
COEN 6711
Concordia University

Winter 2014

Note: Before attaching the FRDM-KL25Z board to your computer, please read the P&E OpenSDA
Firmware section on this document.



Contents

I TInfroducfion| 1
2 Stepl: Keil MDKS Installation process| 1
[3 Step2: P&E OpenSDA Firmware 3
tep3: Attaching - oard to 3

nd: B P i 4
................................... 4
(2 Compiling and Programming] . . . . . ... ... ... ... ... ... .. ... 6
5.3 Debugging|. . . . . . . . 8

[6  mbed development platform:| 9
6.1 Getting started:| . . . . . .. L 9

6.2 Make an mbed Project] . . . . . . . . . ... e 9
[7_You can find more information on creating an mbed program in here] 10

8 Useful Links:| 11


https://mbed.org/handbook/Creating-a-program

1 Introduction

This document guides you through the installation process of the following softwares and drivers on your
PC:

e KEIL MDKS5
e P&E OpenSDA Firmware

Also at the end of this document, you can find a thorough description of the Blinky project. Starting from
building a simple project and adding the necessary libraries/drivers to the project to compiling the source
code and debugging the project while it is executing on the FRDM-KL.25Z platform.

You can find more information about the FRDM-KL25Z platform on the Freescal website. Also, you can
find many useful information regarding this platform on mbed and element14 websites.
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Figure 1: FRDM-KL25Z board pin description

2 Stepl: Keil MDKS Installation process

Keil MDKS is a complete software development environment for almost all of the ARM based microcon-
trollers. MDK-ARM V35 is the latest version which were released in 2013. The installation process is pretty

straight forward:
First you need to download the latest version of MDK-ARM V5 from KEIL|website. Before downloading,

you will be asked to fill out the installation form.


http://mbed.org
http://www.element14.com
https://www.keil.com/download/product/
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A Products Download Events  Support  Videos

Download Products

Select a product from the list below fo download the latest version

e MDK-ARM v5

A 4

h 4

c251

h 4

Version 5.01 (December 2013
Development environment for Cortex and ARM devices.

C51
Version 8.52 (uly 2013)
Development tools for all 8051 devices.

C251
Version 5.55 (July 2013)
Development tools for all 80251 devices.

¥

MDK-ARM v4
Version 4.73 (October 2013)
Development environment for Cortex and ARM devices.

C166
Version 7.52 (July 2013)
Development tools for C166, XC166, & XC2000 MCUs.

Keil products use a License Management system - without a current license the product runs as a Lite/Evaluation edition with a few Limitations

Maintenance Status and Previous Versions

Enter a valid Product Serial Number (PSN) or License Code (LIC) to get access to all product versions available to you, or to check the status
of your support and maintenance agreement.

PSN or LIC:

Further information about installing your software is available in the Read Me First brochure.

After you downloaded the file, you can run the mdk501.exe by double clicking on it. The program will
install on your computer after several minutes. When you have successfully installed the program, the Pack
Installer will pop-up where you can add the CMSIS library and some useful examples specially written for

Figure 2: KEIL|Product page

your specific platform to your program.

5 Pack Installer
File Packs Window Help

Pl

i > ‘ Board: All - Category: ANl ~ [ Installed Examples
4] " Packs | Bxamples |
Pack Action Description
Keil:EFM32TGoor_DFP & Install Energy Micro EFM32 Tiny Gecko Series Device Support
Kell:EFM32WGoo DFP | € Install Energy Micro EFM32 Wonder Gecko Series Device Support
Keil:EFM32Z Grooc_DFP | & Install Energy Micro EFM32 Zero Gecko Series Device Support, Drivers and Examples
Keil:FM3Basic_DFP | & Install Spansion FIM3 Basic Series Device Support
Keil:FM3HighPerformanc... | 5 Install Spansion FM3 High Performance Series Device Support and Examples
Keil:FM3LowPower DFP | & Install Spansion FIM3 Low Power Series Device Support
Keil:FM3UitraLowlLeak_DFP 7@ Install Spansion FM3 Ultra Low Leak Series Device Support
Keil:FM4_DFP | Install Spansion FIVI4 Series Device Support
Keil:Kinetis_K10_DFP | Install Freescale Semiconductor Kinetis K10 Series Device Support
Keil:Kinetis_K20_DFP | & Install Freescale Semiconductor Kinetis K20 Series Device Support and Examples
Keil:Kinetis_K30_DFP 7@ Install Freescale Semiconductor Kinetis K30 Series Device Support
Keil:Kinetis_K40_DFP _@ Install Freescale Semiconductor Kinetis K40 Series Device Support
Keil::Kinetis_K50_DFP _@ Install Freescale Semiconductor Kinetis K50 Series Device Support
Keil:zKinetis_K60_DFP | & Install Freescale Semiconductor Kinetis K60 Series Device Support and Bxamples
| & Install Freescale Semiconductor Kinetis K70 Series Device Support

MDK-Middleware
:5AM3_DFP

After installing your desired libraries and Example package from Pack Installer window, you can then
run the pVision program. You can find how to make a simple project on the 1t Vision User’s Guide

@ Install

Version 1.0.0:

Freescale Semiconductor Kinetis KLy Series Device Support and Examples

1/ First Release version of KL Device Family Pack.

and Examples

| & Install NP LPCT800 Series Device Support, Drivers and Examples

Install MNP LPCB00 Series Device Support

& Upto date | Keil MDK-ARM Professional Middleware for ARM Cortex-M based devices

Install Atmel SAMS3 Series Device Support and Examples

Figure 3: Pack Installer



https://www.keil.com/download/product/
http://www.keil.com/support/man/docs/uv4/uv4_ca_createproject.htm

3 Step2: P&E OpenSDA Firmware

P&E OpenSDA Firmware provides the drivers for programming, debugging and communicating with
FRDM-KL25Z platform. Without this Firmware you are not able to program your device. You can
find the latest version of this software on the P&E micro website . You need to download and install
the PEDrivers_install.exe under the Windows USB Drivers box.

The FRDM-KL25Z platform provides you an onboard debugging capability. On the other hand, OpenSDA
provides you a UART communication channel with the onboard processor(KL25Z). So P&E OpenSDA
Firmware will install not only the programming/debugging driver but also it will create OpenSDA-CDC
serial port on your computer. This driver will add a virtual COM port on your computer when ever you
attach the board to one of your USB ports.

4 Step3: Attaching FRDM-KL25Z board to PC

So far, we have installed the software development environment and P&E OpenSDA Firmware. At this
point, we are all set to attach the board to the computer. Windows will automatically find and install all the
proper driver for the board.

) Driver Software Installation

| Installing device driver software

USE Composite Device < Ready to use
PEMicro/Freescale - CDC Serial Port () Searching Windows Update.
PEMicro/Freescale Debug App ) Searching Windows Update.

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Close

Fi gure 4 Driver software Installation

Since there is a pre-installed bootloader on the FRDM-KL25Z platform, after the first installation of the
board, windows will detect FRDM-KIL.25Z as a storage device. So a new storage device will be added to
your PC. You can drop your executable codes into this drive and OpenSDA will program the board. Since
we are using the KEIL MDKS as our programming environment, it will be more convenient to program the
board using KEIL MDKS as well. For this purpose, we need to change the pre-installed bootloader. First
you need to unplug the board from the USB port and then while you are pressing the reset button re-plug
the board to one of your USB ports. This time a Bootloader drive will appear on your computer.
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Figure 5: Driver software Installation

Now you just need to drag and drop the DEBUG-APP_Pemicro_v108.SDA| on this folder so the next
time you attach the board, you will be able to program it via KEIL. MDKS.


http://www.pemicro.com/opensda/
https://www.dropbox.com/s/e8rarpanuybjehs/DEBUG-APP_Pemicro_v108.SDA

S Step4: Blinky Project

5.1 Create a uVision Project

In this section you can find how to make a simple project in Keil-MDK. In Keil-MDK Select Project> New
uVision project. Find MKL25Z1.128xxx4 in the target device and click OK.

,

cPU
Vendor:  Freescale Semiconductor
Device:  MKL25Z128cod
Toolset:  ARM
Search: Description:
A KLOx ;I Care featurss -
% K1 - 32bit ARM Cortex-M0+ core {up to 48MHz CPU Clock) i
X - Nested vectored intemupt cortr. (NVIC) |
=9 KLax D.»:’ync wzke-up |ntem.t|’p|t contr. (AWIC) 3
ug and trace capability
& MKL24732004 - 2pin serial wire debug (SWD)
B MKL24 764004 - Micro trace buffer (MTE)
- Data watchpoint and tr D
£l MKL2571 28300¢0 2 watchpoint and irace (DVWT)
1 MKL25Z32:004 System and power management
- Software watchdog
1 MKL25Z64100¢ - Integrated bit manipulation engine (BME)
- DMA controller
€3 MKL26712800d - Lowdeakage wake-up unit (LLWL)
€ MKL26Z2561m0d - Power management controller with 10 differert power modes
\,{g KL3x - Non-maskable intermupt (NMI) i
K I Y 51| RN I | )
QK I Cancel Help

In the new window, check the startup option under the Device tab and Core option under the CMSIS tab
and then select OK.

Manage Run-Time Environment M 1 TOWN N =]
Software Component Sel. Variant Version  Description
o€ cuss < cftware Interface Component:
@ CORE i 3.200 (CMSIS- CORE for Cortex-M, SC000, and SC200
@ osp r 141 CHISIS-DSP Library for Corter-hl, SCO00. and SC300
& RTOS (AP) 10 CHISIS-RTOS API for Cortex-M, SC000. and SC300
£ Device Startup. System Setup
@ 2 100 System Startup for Freescale Kl Series
€ Drivers Unified Device Drivers
’ File System MDK-Pro 504 File Access on various storage devices
@4 Graphics MDK-Pro 5221 |UserInterface on grephical LCD displays
@ Network MDK-Pro 504 |IPMetworking using Ethernet or Serial protocols
@ uss MDK-Pro 504 UsBC with various device classes
Validation Output Description

Now we need to write a C code to control the RGB LED on the board. Create a new file by selecting
New under the File tab. Now save the file blinky with .C extension. Make sure that you have added the .c
extension at the end of your file name.



- -
Save As ==
—~
(I [ 11 « MewVolume (D) » Keil ¥ Freedom Board » Blinky » Praject » = |;, |[ search Project 3

Organize v New folder gz - @
Bl Desktop *  Name B Date modified Type Size
| Downloads
T | RTE 12/24/20138:40 PM  Fille folder
. pr ::I &) Blinky.build_loghtm 12/24/20128:41PM  Firefox HTML Doc... 1B
S TECEmTREE 1 L BlinkyuvguiHOSSEIN 12/24/20128:36 PM HOSSEIN File 68 KB
e ] Blinky.uvguix HOSSEIN 12/24/20138:40 PM  HOSSEIN File 65 KB
ﬂ@‘;"es . || Blinky.uvopt 12/24/20128:36 M UVOPT File 5KB
2 M“”m” : || Blinky.uvoptx 12/24/20128:40 PM UVOPTX File 7B
o :': ] Blinky.uvproj 12/24/20128:40 PM  iVisiond Project 0Ke
= V‘d ures ] Blinky.uvprojx 12/24/20128:40 PM  iVisions Project 17 kB
ideos
% Homegroup 3
File name: .
Save as type: [ Al Files () -

This C file will be later compiled so we need to add it to our project:

=@ =
EELILY X N=EEY
" Basons [rre— 0 e o s o T
4 Device Froct s | FldeeBeensons | Books | ook [ Pt Cleasm
Name - Date modfied T
s EIXI37%]fooen ST s 6
EC e it mm() i
ttpn, oS ol s
[T
s )
I — e .
Do e
uuuuuuuuu oK Cancel b *8

Now you should be able to find your C file under the Source Group 1 tab. Copy and paste the following
code into blinky.c. Make sure that you have Delay.h/file in your project folder.

#include <MKL25Z4.H>
#include "Delay.h"
const uint32_t led_mask = 1UL << 1;

Y
MAIN function
K - */
int main (void) {
SystemCoreClockUpdate () ; /* Get Core Clock Frequency */
SysTick_Config(SystemCoreClock/1000) ; /* Generate interrupt each 1 ms */
SIM->SCGC5 |= (1UL << 12); /* Enable Clock to Port D */
PORTD->PCR[1] = (1UL << 8); /* Pin PTD1 is GPIO */
FPTD->PDOR = led_mask; /* switch Blue LED off */
FPTD->PDDR = led_mask; /* enable PTD1 as Output */
while(1) {

FPTD->PCOR = led_mask;
Delay (500);
FPTD->PDOR
Delay(500) ;
}
}

led_mask;



https://www.dropbox.com/s/g95xndlgfd6u2jb/Delay.h

5.2 Compiling and Programming

In order to compile your code, simply click on ”Rebuild all the target files” under the Project Tab. You
should be able to compile the code without any errors or warnings.

20
21

EProjeﬂ@Books {} Func... O, Tem... 4 L]

Build Output

Bebuild target 'Target 1°'
compiling blinky.c...
assembling startup MEKL2Z5Z4.s...
compiling system MKL25Z4.c...
linking...

v = i ata=1124
.%Blinky.axf" - 0 Error(s), 0 Warning(s).

This C code still cannot be run on the microcontroller. We need to generate the Intel HEX file out of
this code:

Boss ity I = 0 =
Flle Edit View Project Flash Debug Peripherals Tools SVCS Window Help
NSEd| s cB[92c |« [ BEn IE 1] @& Hav ale oa
(S EE e ] 8 et Ry
Project 2 = v x
=521 Target 1 1 #include <MKL25Z4.H>
E145 Source Group 1 2 const uint32_t led mask = 1UL €< 1;
3/
4 MAIN function
N . 4 r . N
A Options for Targat ‘Targat 1°
I —— pions for Target T ==
7  SystemCoreClockUpd o
utpt e
& SysTick Confiz(Syd Device | Targ: tput Yuisting | User | C/C++| Asm | Linker | Debug | Utities |
s sm>scecs (= 2
3 10  PORTD->BCR[1] = Select Foldzrfor Objects... Name of Executable: [Binky
11 FETD->PDOR = led
12  FETD->EDDR = led m
P 1 & Create Excoutable: \Binky
14 while(1) { Debug Infornation I™ Create Batch File
15 FPTD-»PCOR = 1|
16 3 W Jpreate HEX File
17 )
. Browse Information
2 € Create Library: .\Binkyli
20
21
I L (S i ) S — '
Rebuild target 'Target 1° 3
compiling blinky.c...
assembling starcup MKL25Z4.s... Cancel | [ Defauts | Hep |
compiling system MRL25Zé.c...
linking. ..
Program Size: Code=1376 RO-data=224 RW-data=4 ZI-data=1124
".\Blinky.axf" - 0 Ezrzor(s), O Wazaing(s).
< 3
3 error List | E] Build output
PEMIcro Debugger L1t CAP NUM SCRL| OVR| RAW



We need to set the OpenSDA as the programming and debugging tool. In the same window under the
Debug tab select PEMicro Debugger and then select OK.

' B
Options for Target Target 1' g
Device I Target I Output I Listing I User I CJ'CH' Asm I Linker Debug | Ltilties I
~ Use Simulator Settings . |PEMicro Debugger ;I Settings |
[~ Limit Speed to Real-Time Altera Blaster Cortex Debugger s
Stellaris ICDI
- . Signum Systems JTAGjet b ;
' '3 '
¥ Load Application at Startup ¥ Run to main{) ¥ Load JLINK 7 J-TRACE Corteet b main()
Initiglization File: Initializatiq |JLINK Pro Cortex Debugger
. MNULink Debugger = .
| J Edi. | [ SiLabs UDA Debugger J Edi. |
) - ST-Link Debugger
Restore Debug Session Settings————————————————————— Restore CMSIS-DAP Debugger
V¥ Breakpoints V¥ Toolbox |¥ B Fast Models Debugger
PEMicro Debi
v Watch Windows & Performance Analyzer v wars T
¥ Memory Display ¥ Memory Display

CPUDLL: Parameter: Diriver DLL: Parameter:
ISAF{MCMS.DLL | ISAF{MCMS.DLL |
Dialog DLL: Parameter: Dialog DLL: Parameter:
IDAF{MCMTDLL |1;crum+ ITﬁHMCMlDLL I-pCI'u'ID+
P
( 3 0K Cancel |  Defauits | Help
. .

Now we just need to program the board with the generated hex file. Under the Flash tab, select Down-
load option. You need to specify the target device that you are going to program. Select KL.25Z128M4
from the "Choose Device” window and then click OK.

e >
T Choose Device o] B [
KLOSZ32M 4 a

KLD2Z8M4

KLD2Z16M4
KLO2Z32M4
KL14Z32M4

KL16Z32M4
KL16Z64M4
KL16Z128M4
KL16Z256M4
KL24Z32M4
KL24Z64M4
KL25Z232M4
KL26Z64M 4
KL26Z32M4

KL26Z64M4

KL26Z128M4
KL26Z256M4
KL34Z64M4
KL36Z64M4
KL36Z128M4

KM14Z64M5
KM142128M5
KM32Z64M5
KM33Z64M5

X cance




On the opened window (PEMICRO Connection Manager) make sure that you have selected "OpenSDA
Embedded Tower Debug USB-Port” from the Interface box. Also make sure that you have selected "Use
SWD reduced pin protocol for communications” and then hit the Connect button in order to program the

board. Press reset button on the board to let the program execute.

r .
PEMICRO Connection Manager [(x]

Wou have selected to display this dialog on startup. Specify communications
parameters and click OK.

[ Connection port and Interface Type
Add LPT Part
Interface: |LISE Mullilink, USE Mulliink F, or Embedded D5.Jtag Y| Tt |
Fiefresh List
ARM Cable, Connected via Parallel Port or BDM Lightring —
Part: |USE Multilink, USE Multilink Fx, or Embedded 05.Jtag Help?]

Cyclone - Serial Port

Irterface D Cyclone - Ethernet Port

Cuclone - USE Part
: git

[ Target C]
CH

[ BD'M Communication 5peed

PC Parallel Port wait states : 10_DELAY _CHT = i}

Diebug Shift Speed = [ 0]  Muliink = 1.00Mhz . Mullirk Fx = 25.00Mhz . DSITAG = 0.28Mhz  ~|
SO cEEED 0

v Use 5%/D reduced pin protocol for communications I 2

[ MCU Intemnal Bus Frequency (For programming]
@ Auto-Detect

¢ MCU Intemal Bus frequency (FREQ] in Hz = a [Decimal]

Reset Option
I~ Delay after Reset and before communicating ta target far 0 miliseconds [decimal).

[ Power Control for Cyclone / TraceLink ¢ Multilink Universal Fr
I~ Provide power to target Regulstar Output Yoltage Power Diown Delay I 250 mg

I~ Power off target upon software et Y I Pawer Up Delay I 1000 5
=]
Connect (Reset) | Hotsync Abort |

contact target [Dtherwise only display on Error]

5.3 Debugging
To debug your code while it is executing on the board press Ctrl+F5 or selet start/stop under the Debug tab.

4 DAKeilFreedom Board\ied2\led2 uvproj - pVision 1
File Edt View Projec Flosh Debug Peripherals Tools SVCS Window Help

NEWd s B9 c|e|p

X [EER

HEBo|lareule
Registers 2 @ Oisassembly '@
e Tvae 1 7: SystemCor=ClockUpaate (); 7+ Get Cove Clock Frequency =/ &
168 FOOOF97B BL.W SystemCoreClockUpdate (0x00000462)
5:  SysTick Config(SystemCoreClock/10); /* Generate interrupt each 1000 ms  */ B
0x0000016C 2108 Hovs x1,$0x0n J
'0x0000016E 4830 LDR xr0.loc.#1921 : R0x00000230 =
« B
leddc | [5] startup MKL25Z45 system MKLZS24.c - x
1% de <MKL25Z4.H>
2 const wintaz_c led mask = 10L << 1;
2 conse uinesz v 3ed <«
TR 4 MAIN function
5 /

FFFDEFFE
000000640

§1int main (void) {
/% Get Core Clock Freguency ~/

BSY 7 SystemCoreClockUpdate():
&8  SysTick Config(SystemCoreClock/10) ; /* Generate interrupt each 1000 ms  */
® o smoscacs = (10D << 12); /+ Enable Clock to Bort D =/
10 PORID->FCR[1] = (UL << 9); /* Pin PID1 is GPIO */
11 FPID->PDOR = led mask: /+ switen Blue LED off
12 FPTD->EDIR = led mask; /+ enable FTDI as Output +/

14 wnile(1) {
15 EPID->PCOR = led mask;

ot | ERegiters «
=

Commana 5B Callstack - Locsls
| Name Location/Value Type
Breakpoint Encountered. @ "
Preoer in Hereon - main 0000168 intf0
>
ASSIGN Breakbisable BreakEnsble BreakKill BreakList BreakSet Breakhccess COVERAGE DEFINE DIR | acon stock - tocats [Evremon ©
PEMicro Debuaaer 000000000 5ec L7 CL AP NM! SCRL OVRl R

Use F11 and F5 to execute the program step by step. This program will blink LED



6 mbed development platform:

mbed development platform is an online development kit which supports many ARM based platforms from
different vendors. Fortunately, FRDM is one of the well supported platform by mbed. Before going to the
next section, make sure that you have created an account on the mbed website|.

6.1 Getting started:

To get started, you need to re-program the BOOTLOADER of the microcontroller in order to be able to
program the board using the .bin files. You can download this BOOTLOADER from fhere. Using this new
BOOTLOADER, re-boot the board according to the section four of this document. You can find more
information on how to re-boot the board in here. If you re-boot the board properly, you should be able to
see the "MBED” Folder on your computer after you re-plugged the board.

n
‘
=
®

Organize v System properties  Uninstall or changea program  Map networkdrive  Open Control Panel

4 Hard Disk Drives (3)
Local Disk (C:) New Volume (D) New Volume (E)

# 515G free of 76 GB S Mo - S s eneecrors e
4 Devices with Removable Storage (2)
S MBED (G}
DUD RW Drive (F) =
E—$ S 125 B free of 144 KB
18 Computer
o= MBED (G)

€ Network
|| HOSSEIN-PC Workgroup: WORKGROUP Memory: 4.00 GB

Processor; Intel(R) Core(TW) i7 CP..

6.2 Make an mbed project:

Once you log into your mbed account, click on the Compiler button in order to use the mbed Compiler:

n Handbook Cookbook Platforms Components Code Questions Forum Dashboard

mbed - I

Development Platform for Devices

The mbed development platform is the fastest way to create b I OX
products based on ARM microcontrollers. C027-C20/U20/G35

The project is being developed by ARM, its Partners and the
contributions of the global mbed Developer Community.

Find out why you should base your next ARM microcontroller 7 mbed enab\e
powered product on the mbed platform » coz

In the new window, right click on "My Programs” and select "New Program”. In the ”Create New Pro-
gram” window, make sure that you have selected the "Blinky LED Hello World” option from the template
menu. Provide a name on the Program Name box and click on OK:


https://mbed.org/account/signup/?next=/
http://mbed.org/media/uploads/sam_grove/mbed_if_v2.1_frdm_kl25z.s19
http://mbed.org/handbook/Firmware-FRDM-KL25Z

FyNew v P import | L Save [ Save Al | (£ Comple v | (% Conmit v (7 Revisins | x5 o | # | £ | N | Cep

|
ig' Manage your Program Workspace

Choose which programs are open in your Program Workspace.

your Program Workspace

Tags.

| Modified Description

“Your Program Workspace is empty. You can import a proaram or greste a new one.

Create new program

Create new program for Freescale KL25Z

“This wll reate @ nen C++ program for Freescale KL252 in your Q
workspace. You can alnays change the platform of ths program
once created.

@ Please specify program name and template

Template: [ & sinky LD reto vorid
=

The name of the program ta be created in your
workspace

[]
J

Since you have selected a "Blinky LED Hello World” template for your project, the main code is already
generated by the program and you don’t need to add anything to the project. On the left hand side of the

compiler, double click on the main.cpp file and review the generated code. To generate a .bin file from this
project, you need to compile the code. Click on the "Compile” button:

& N Drep Freescale K257 @
& xpand
de
Digitalout myled (LED1);
int main() {
while(1) {
myle
}
3
Compile output for program: Test Errorsi0 | Warningsi0 | Infos: 1
Desaription Ermor Number | Resource | In Folder Location
 Success! Buid Detaik
Ready. ms

The software will compile your code and if the compilation was successful, it will provide you a link to

download the .bin file. Save the .bin file on the "MBED” folder on your computer and press the reset button
on the board to allow the execution of your program on the microcontroller.

7 You can find more information on creating an mbed program in
here.

10


https://mbed.org/handbook/Creating-a-program

8 Useful Links:

Creating a pvision Projects
MDK-ARMS

FRDM-KL25Z Product Page
MDKS Software Packs
FRDM-KL257 User’s Manual

11


http://www.keil.com/support/man/docs/uv4/uv4_ca_createproject.htm
https://www.keil.com/download/product/
http://www.freescale.com/webapp/sps/site/prod_summary.jsp?code=FRDM-KL25Z
http://www.keil.com/dd2/pack/
http://www.embest-tech.com/resource/download/FRDM-KL25Z%20User%20Manual.pdf
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